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Preface 

The purpose of this manual is to provide the user with the information required to 
install the IHS Emergency Department Dashboard (EDD). 

Caché® and Ensemble® are both registered trademarks of InterSystems Corporation. 

Windows® and Internet Information Server® are registered trademarks of 
Microsoft® Corporation. 
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1.0 Release Notes 
The EDD is a tool that electronically enables facilities to run and manage their 
emergency and or urgent care clinics. It is dependent on the Resource and Patient 
Management System (RPMS) Emergency Room System (ERS) in the AMER 
namespace. EDD was built on the ERS foundation to enhance patient flow and 
provider communication. 

EDD can be set up to operate as a standalone icon on the staff computer or can be 
accessed from within the RPMS Electronic Health Record (EHR) application. 

EDD gets its data and updates from one of four ways: ERS, Dashboard Edit, EHR 
data, or a combination of all three. 
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2.0 Installation Notes 
Prefix: BEDD 
Current Version: 1.0 

 

Note: Read entire notes file prior to attempting any installation. 

• All patches to v1.0 will be cumulative 

• Make a copy of this distribution for offline storage. 

• Print all notes and readme files. 

• Capture terminal output during the Kernel Installation and Distribution System 
(KIDS)installation using an auxiliary port printer attached to the terminal at which 
the user is performing the software installation or using a screen capture. This 
capture combined with the KIDS entry in the INSTALL file will ensure a printed 
audit trail should any problems arise. 

2.1 Contents of Distribution 
File Description 
bedd0100.xml Ensemble import file 

bedd0100.k KIDS file 

bedd010i.pdf Installation Guide and Release notes 

bedd010u.pdf User Manual 

bedd010t.pdf Technical Manual 

Bedd010s.pdf Security Manual 

2.2 Required Resources 
Module/Software Minimum Version 
InterSystems Ensemble v2010.2.3 or later 

VA FileMan (DI) v22.0 Patch 1003 

VA Kernel (XU) v8.0 Patch 1015 

PCC Data Entry (APCD) v2.0 through Patch 10 

Patient Registration (AG) v7.1 Patch 10 

ER Visit System (AMER) V3.0 Patch 4 
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3.0 BEDD XML/Ensemble Installation 
This section begins the BEDD installation process. It describes the process of 
importing the BEDD application into Ensemble Studio from an XML file. 

3.1 Import the BEDD XML file 

3.1.1 Open Ensemble Studio 
1. Click the Ensemble cube in the system tray (at the right end of the Windows 

Taskbar) to display the Ensemble Studio menu (Figure 3-1). 

 
Figure 3-1: Ensemble Studio menu 

2. Select Studio. A login ID and password may be required. The Ensemble Studio 
window (Figure 3-2) displays. 

 
Figure 3-2: Ensemble Studio window, Change Namespace option on File menu 

3. On the File menu, select Change Namespace to open the Cache Connection 
Manager dialog (Figure 3-3). 
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Figure 3-3: Cache Connection Manager dialog 

4. Select RPMS from the Namespace list and click OK. 

3.1.2 Import the bedd0100.xml File 

 
Figure 3-4: Ensemble Studio window, Import Local option on Tools menu 

1. On the Tools menu, select Import Local (Figure 3-4) to display the Open file 
dialog (Figure 3-5). 
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Figure 3-5: Open file dialog 

2. Locate the file bedd0100.xml. 

3. Click Open to display the Import dialog (Figure 3-6). 

 
Figure 3-6: Import dialog 

4. Select all items displayed in the Import dialog. 

5. Select the Compile Imported Items option. 



IHS Emergency Department Dashboard (BEDD) Version 1.0 

Installation Guide BEDD XML/Ensemble Installation 
May 2013 

6 

6. Click OK. Once the package files are compiled, the “Compilation finished 
successfully in…” message appears in the Output pane (Figure 3-7). 

 
Figure 3-7: Output pane 

7. If a warning dialog similar to Figure 3-8 displays after the XML file is imported, 
click OK to continue. 

 
Figure 3-8: Studio warning dialog 
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4.0 Configuring the Cache Server Page Application 
Note: Use a standalone IIS or Apache web server with SSL 

configuration and not the web server provided by 
InterSystems. The instructions here are for testing purposes 
only. 

Configure the security settings for the EDD Cache Server Page (CSP) application that 
was automatically created by the import and compile process. Failure to complete this 
step, will cause the EHR to be unable to display the EDD main dashboard page. 

4.1 Enable System Authentication Options 
1. Log on to the Ensemble System Management Portal. 

2. Select Security Management under System Administration in the left column 
to display the Security Management page. 

3. Select System Security Settings under Security Definitions in the left column to 
display the Security Setting Options page. 

4. Select Authentication Options in the left column to display the Authentication 
Options page (Figure 4-1). 

 
Figure 4-1: Authentication Options page 

5. Ensure that Allow Unauthenticated access is selected. 

6. Click Save. The change will take effect immediately. 
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4.2 Create New CSP Application 
From the main Ensemble Management Portal page: 

1. Select Security Management under System Administration in the left column 
to display the Security Management page. 

2. Select CSP Applications in the right column under Application Definitions to 
display the CSP Applications page (Figure 4-2): 

 
Figure 4-2: CSP Applications page 

3. Click Create New CSP Application to display the Edit CSP Application page 
(Figure 4-3). 
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Figure 4-3: Edit CSP Application page, General tab 

4. Type /csp/bedd in the CSP Application Name field. 

5. Type ED Dashboard in the Description field. 

6. Select Unauthenticated at Allowed Authenticated Methods. 

7. Select the site’s RPMS namespace from the Namespace list. 

8. At CSP Files Physical path, click Browse and locate the directory, setting the 
path (it should be in the format <cacheinstance>/csp/<RPMSinstance>). 

9. Type BEDDLogin.csp (this is case sensitive) in the Login Page field. 

4.3 Update Ensemble’s UnknownUser 
From the main Ensemble Management Portal page: 

1. Select Security Management under System Administration in the left column 
to display the Security Management page. 

2. Select Users in the left column to display the Users page (Figure 4-4). 
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Figure 4-4: Users page 

3. Locate the user UnknownUser in the table. 

4. Click the Edit link in the UnknownUser row to display the Edit User page, 
General tab (Figure 4-5). 

 
Figure 4-5: Edit User page, General tab 

5. Select the Roles tab to display the Edit User page, Roles tab (Figure 4-6). 
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Figure 4-6: Edit User page, Roles tab 

6. Do one of the following: 

• If the list of roles at the top of the tab includes %All, no further action in this 
section is required. 

• If the list of roles at the top of the tab does not include %All, select %All in 
the Available list and click the single right-pointing arrow located between 
the Available and Selected lists. With %All in the Selected column, click 
Assign and %All appears in the list of roles at the top of the tab (Figure 4-7). 
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Figure 4-7: Edit User page, Roles tab 
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5.0 CSP Gateway Installation 
The CSP Gateway provides the communications layer between the hosting Web 
server and Ensemble when you call a CSP. The purpose of using the CSP Gateway is 
to offload the access to the EDD application to a dedicated web server, as well as use 
Secure Socket Layer (SSL) communication to encrypt the data between the user and 
the server.  

Note: The instructions in this section assume the site is running 
Microsoft Internet Information Server (version 7 or higher) 
with a valid installed SSL certificate. Installation of IIS and 
SSL certificates are outside the scope of this document. 

5.1 Install Cache Shell 
1. Launch the Ensemble executable appropriate for your version of Windows. The 

Ensemble – Installation: License Agreement dialog (Figure 5-1) displays. 

 
Figure 5-1: Ensemble – Installation: License Agreement dialog 

2. Select I accept the terms in the license agreement. 

3. Click Next. The Ensemble – Installation: Ensemble Instance Name dialog 
(Figure 5-2) displays. 
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Figure 5-2: Ensemble – Installation: Ensemble Instance Name dialog 

4. Type a unique name for this physical machine in the Ensemble Instance Name 
field 

5. Click Next. The Ensemble – Installation: Destination Folder dialog (Figure 
5-3) displays. 

 
Figure 5-3: Ensemble – Installation: Destination Folder dialog 
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6. To select a destination folder other than that displayed below Install Ensemble 
to: 

a. Click Change. The Ensemble – Installation: Change Current Destination 
Folder dialog (Figure 5-4) displays. 

 
Figure 5-4: Ensemble – Installation: Change Current Destination Folder dialog 

b. Type the path C:\InterSystems\EnsembleCSP\ into the Install Folder field. 

c. Click OK to return to the Ensemble – Installation: Destination Folder 
dialog (Figure 5-3). 
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7. Click Next. The Ensemble – Installation: Setup Type dialog (Figure 5-5) 
displays. 

 
Figure 5-5: Ensemble – Installation: Setup Type dialog 

8. Select Web Server. 

9. Click Next. The Ensemble – Installation: Ready to Install the Program dialog 
(Figure 5-6) displays. 

 
Figure 5-6: Ensemble – Installation: Ready to Install the Program dialog 

10. Review the selected options; click Back to make changes. 
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11. Click Install. If IIS is running, the Question dialog (Figure 5-7) appears: 

 
Figure 5-7: Question dialog 

• Click Yes to stop IIS and continue the installation process. 
The Ensemble – Installation: Ensemble Installation Completed dialog (Figure 
5-8) displays. 

 
Figure 5-8: Ensemble – Installation: Ensemble Installation Completed dialog 

12. Click Finish. 

5.2 Configure IIS 
1. Remote connect to the web server that hosts the CSP gateway. 

2. Open Administrative Tools and select Internet Information Services (IIS) 
Manager (Figure 5-9). 
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Figure 5-9: Administrative Tools: Internet Information Services (IIS) Manager 

The IIS Manager page (Figure 5-10) displays. 

 
Figure 5-10: IIS Manager page 

3. In the Connections pane, expand Default Web Site then select csp. 
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4. In the /csp Home pane, click Handler Mappings to display the Handler 
Mappings pane (Figure 5-11). 

 
Figure 5-11: IIS Manager page: Handler Mappings pane 

5. Verify that the four CSPGateway_* mappings are present (Path values: *.cls, 
*.csp, *.cxw, and *.zen), and that each one’s State column value equals Enabled. 

6. To configure IIS handle CSP applications like EDD via IIS, click Add Module 
Mapping in the Actions pane to display the Add Module Mapping dialog 
(Figure 5-12). 

 
Figure 5-12: Add Module Mapping dialog 
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7. Type *.* in the Request path field. 

8. Select CSPms from the Module drop down list. 

9. Type CSP in the Name field 

10. Click OK. 

5.3 Configure CSP Gateway 
1. While connected to the web server that hosts the CSP gateway: 

a. Open a web browser. 

b. Type the following URL into the browser address field: 
http://localhost/csp/bin/Systems/Module.cxw 

The CSP Web Gateway Management page (Figure 5-13) displays. 

 
Figure 5-13: CSP Web Gateway Management page 

http://localhost/csp/bin/Systems/Module.cxw
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2. Click Server Access in the left pane to display the Server Access pane (Figure 
5-14). 

 
Figure 5-14: CSP Web Gateway Management page: Server Access pane 

3. Click Add Server. The page contents change to accept values for the new server 
(Figure 5-15). 

 
Figure 5-15: CSP Web Gateway Management page: Server Access pane 

4. Insert the appropriate site information into the following fields: 

• Server Name 

• IP Address 

• User Name 

• Password and Password (Confirm) 
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5. Scroll to the bottom of the pane and click Save Configuration. 

6. Select Application Access from the left pane. The Application Access pane 
(Figure 5-16 displays. 

 
Figure 5-16: CSP Web Gateway Management page: Application Access pane 

7. Click Add Application. The page contents change to accept values for the new 
application (Figure 5-17). 

 
Figure 5-17: CSP Web Gateway Management page: Application Access pane 
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8. Insert the appropriate site information into the following fields: 

• Application Path: type /csp/bedd 

• Default Server: select the Server Name set in Step 4 from the dropdown list 

9. Scroll to the bottom of the pane and click Save. 

10. Select Test Server Connection from the left pane. When complete, the Test 
Server Connection pane (Figure 5-18) displays. 

 
Figure 5-18: CSP Web Gateway Management page: Test Server Connection pane 

11. Type the website link for the ED Dashboard into the browser address field: 
https://npacsmtbmw.d1.na.ihs.gov/csp/bedd/BEDDLogin.csp 
the BEDD Emergency Room Dashboard Login page (Figure 5-19) displays. 

 
Figure 5-19: BEDD Emergency Room Dashboard Login page 

Note: If using a non-standard port for the https protocol handled 
by IIS such as 444, modify the URL accordingly as in the 
following example: 
https://npacsmtbmw.d1.na.ihs.gov:444/csp/bedd/BEDDLog
in.csp 

https://npacsmtbmw.d1.na.ihs.gov/csp/bedd/BEDDLogin.csp
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6.0 BEDD KIDS Installation 
This section details the steps required to install the EDD KIDS package. This is a new 
package with new routines, so there should not be anything on the system to back up 
or compare. 

Also, no options need to be taken out of service because the components to be added 
will not be directly added to any existing options. 

6.1 Pre-Installation 
• If possible, initially load the software into a test account, then into the production 

account. There are no routines or globals to remove after the installation is 
complete. 

• Refer to the BEDD Installation steps (Section 6.2) and its corresponding Sample 
BEDD Installation (Section 6.3) for the applicable prompts and user responses. 
User responses appear in bold type. 

6.2 BEDD Installation 
1. From the KIDS menu, select the Installation menu and press Enter. 

2. From the XPD Main > Installation menu, select Option 1: Load a Distribution and 
press Enter. 

3. Type bedd0100.k at the “Enter a Host File” prompt and press Enter. 

Note: The file path might need to precede the file name with the 
appropriate host path. This is the file to retrieve from the 
appropriate software directory. 

4. Press ENTER (to accept the default) at the “Want to Continue with Load?” 
prompt. 

KIDS file bedd0100.k contains the following installation file: 

BEDD DASHBOARD 1.0 

5. At the Installation menu, select “Option 2: Verify Checksums in Transport 
Global” and press Enter. This option provides a mechanism for ensuring the 
integrity of your routines. It verifies checksums for the components of the 
Transport global, and reports any errors uncovered. 

6. Type BEDD DASHBOARD 1.0 as the install name and press Enter. 
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Optional: At this time, you can elect to exercise one of the following installation 
options. If you elect to use one of these, use BEDD DASHBOARD 1.0 as the install 
name. 

• Back Up a Transport Global – this option creates a MailMan message that will 
back up all current routines on the system that would be replaced by this 
release. (Because this is a new release no files will be replaced.) 

• Compare Transport Global – this option allows you to view all changes that 
will result from the installation of this patch and compares them with the 
values currently loaded on the system (routines, data dictionaries, templates, 
etc.). 

7. From the Installation menu, select the Install Packages(s) option and press Enter. 

8. At the “Select Install Name” prompt, type BEDD DASHBOARD 1.0 and press 
Enter 

9. At the “Want KIDS to Rebuild Menu Trees Upon Completion of Install?” prompt, 
type NO and press Enter. 

10. At the “Want KIDS to INHIBIT LOGONs during the install?” prompt, type NO 
and press Enter. 

11. At the “Want to DISABLE Scheduled Options, Menu Options and Protocols?” 
prompt, type NO and press Enter. 

12. Type the name of the device that will print the install messages and press Enter. 

13. Exit the Installation menu. 

6.3 Sample BEDD Installation 
Select OPTION NAME: XPD MAIN      Kernel Installation & Distribution System 
 
          Edits and Distribution ... 
          Utilities ... 
          Installation ... 
          Patch Monitor Main Menu ... 
 
Select Kernel Installation & Distribution System Option: Installation 
 
   1      Load a Distribution 
   2      Verify Checksums in Transport Global 
   3      Print Transport Global 
   4      Compare Transport Global to Current System 
   5      Backup a Transport Global 
   6      Install Package(s) 
          Restart Install of Package(s) 
          Unload a Distribution 
 
Select Installation Option: 1  Load a Distribution 
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Enter a Host File: D:\RPMS_TEST\bedd0100.k          [A site specific path 
is required here] 

 
KIDS Distribution saved on Sep 10, 2012@14:44 
Comment: BEDD DASHBOARD 1.0 
 
This Distribution contains Transport Globals for the following Package(s): 
Build BEDD DASHBOARD 1.0 
 
Distribution OK! 
Want to Continue with Load? YES//  YES 
Loading Distribution... 
 
   BEDD DASHBOARD 1.0 
Use INSTALL NAME: BEDD DASHBOARD 1.0 to install this Distribution. 
 
   1      Load a Distribution 
   2      Verify Checksums in Transport Global 
   3      Print Transport Global 
   4      Compare Transport Global to Current System 
   5      Backup a Transport Global 
   6      Install Package(s) 
          Restart Install of Package(s) 
          Unload a Distribution 
 
Select Installation Option: 2  Verify Checksums in Transport Global 
Select INSTALL NAME:   BEDD DASHBOARD 1.0   Loaded from Distribution   
Loaded from Distribution  9/11/12@08:21:12 
     => BEDD DASHBOARD 1.0  ;Created on Sep 10, 2012@14:44 
 
This Distribution was loaded on Sep 11, 2012@08:21:12 with header of 
   BEDD DASHBOARD 1.0  ;Created on Sep 10, 2012@14:44 
   It consisted of the following Install(s): 
BEDD DASHBOARD 1.0 
 
Want each Routine Listed with Checksums: Yes//   YES 
DEVICE: HOME//   VT 
 
PACKAGE: BEDD DASHBOARD 1.0     Sep 11, 2012 8:21 am                 PAGE 1 
-------------------------------------------------------------------------- 
 
BEDDEHR   Calculated    2045184 
BEDDEHRS  Calculated   21599952 
BEDDMREC  Calculated   32819285 
BEDDTRPT  Calculated    6329164 
BEDDUTID  Calculated  120458405 
BEDDUTIF  Calculated     694696 
BEDDUTIL  Calculated  160491231 
BEDDUTIU  Calculated  122967103 
 
   8 Routines checked, 0 failed. 
   1      Load a Distribution 
   2      Verify Checksums in Transport Global 
   3      Print Transport Global 
   4      Compare Transport Global to Current System 
   5      Backup a Transport Global 
   6      Install Package(s) 
          Restart Install of Package(s) 
          Unload a Distribution 
 
Select Installation Option: 6  Install Package(s) 
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Select INSTALL NAME:    BEDD DASHBOARD 1.0     Loaded from Distribution     
Loaded from Distribution  9/11/12@08:21:12 
     => BEDD DASHBOARD 1.0  ;Created on Sep 10, 2012@14:44 
 
This Distribution was loaded on Sep 11, 2012@08:21:12 with header of 
   BEDD DASHBOARD 1.0  ;Created on Sep 10, 2012@14:44 
   It consisted of the following Install(s): 
BEDD DASHBOARD 1.0 
Checking Install for Package BEDD DASHBOARD 1.0 
 
Install Questions for BEDD DASHBOARD 1.0 
 
Want KIDS to INHIBIT LOGONs during the install? NO//  NO 
Want to DISABLE Scheduled Options, Menu Options, and Protocols? NO//  NO 
 
Enter the Device you want to print the Install messages. 
You can queue the install by enter a 'Q' at the device prompt. 
Enter a '^' to abort the install. 
 
DEVICE: HOME//   VT 
-------------------------------------------------------------------------- 
 
 Install Started for BEDD DASHBOARD 1.0 : 
               Sep 11, 2012@08:21:26 
 
Build Distribution Date: Sep 10, 2012 
 
 Installing Routines: 
               Sep 11, 2012@08:21:27 
 
 Installing PACKAGE COMPONENTS: 
 
 Installing SECURITY KEY 
               Sep 11, 2012@08:21:27 
 
 Updating Routine file... 
 
 Updating KIDS files... 
 
 BEDD DASHBOARD 1.0 Installed. 
               Sep 11, 2012@08:21:27 
 
 Not a VA primary domain 
 
Install Completed 

Figure 6-1: Sample BEDD KIDS installation 
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7.0 Add User Security Keys 
This section covers entering the appropriate security key to RPMS users requiring 
access to the BEDD application 

There are two keys installed as part of the KIDS build 

• BEDDZMGR – Key for Manager access to the ED Dashboard application 

• BEDDZDASH – Key for User access to the ED Dashboard application 
Add user security keys to RPMS users using the XUKEYMGMT option as shown in 
Figure 7-1. 

1. At the “OPTION NAME:” prompt, type KEY MAN and press Enter. 

2. At the “CHOOSE 1-2:” prompt, type 1 (XUKEYMGMT) and press Enter. 

3. At the “Select Key Management Option:” prompt, type ALLOC and press Enter. 

4. At the “Allocate Key:” prompt, enter BEDDZDASH and press Enter. 

5. If the user also needs Manager access to this application, at the “Allocate Key:” 
prompt re-appears after the previous step, enter BEDDZMGR and press Enter. 

6. At the “Holder of Key:” prompt, enter the user’s name to which the keys are to be 
added and press Enter. 

7. At the “You are allocating keys. Do you wish to proceed?” prompt, verify your 
entry and type YES if correct or NO if not, and press Enter. 

Select OPTION NAME: KEY MAN 
     1   KEY MANAGEMENT  XUKEYMGMT     Key Management 
     2   KEY MANAGEMENT  BEHOORKY MAIN     Key Management 
CHOOSE 1-2: 1  XUKEYMGMT     Key Management 
 
          Allocation of Security Keys 
          De-allocation of Security Keys 
          Enter/Edit of Security Keys 
          All the Keys a User Needs 
          Change user's allocated keys to delegated keys 
          Delegate keys 
          Keys For a Given Menu Tree 
          List users holding a certain key 
          Remove delegated keys 
          Show the keys of a particular user 
 
Select Key Management Option: ALLOCation of Security Keys 
 
Allocate key: BEDDZDASH 
 
Another key: BEDDZMGR 
 
Another key: 
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Holder of key: USER,TEST 
 
Another holder: 
 
You've selected the following keys: 
 
BEDDZMGR       BEDDZDASH 
 
You've selected the following holders: 
 
USER,TEST 
 
You are allocating keys. Do you wish to proceed? YES// 
 
BEDDZMGR being assigned to: 
     USER,TEST 
 
BEDDZDASH being assigned to: 
     USER,TEST 

Figure 7-1: Key Management – Allocate Key(s) 
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8.0 Application Access Setup 
There are two modes of operation for the EDD - Standalone and EHR Portal. 

• Standalone - access via a direct web browser session which requires an active 
RPMS User and Verify code to login. 

• EHR portal - access from within the EHR application as separate tab. Note that 
this also requires an active RPMS User and Verify code to login, however the 
user may already have their credentials cached in the EHR application. 

8.1 Stand Alone Setup 
For standalone access, create an icon on your desktop to call up your web browser for 
access: 

1. Right click at a blank area of the Windows desktop to display the actions menu. 

2. Select New to display the submenu. 

3. Select Shortcut to display the Create Shortcut wizard, select item step (Figure 
8-1). 

 
Figure 8-1: Create Shortcut wizard, select item step 

4. In the Type the location of the item field, type the following URL (site-specific 
modifications in [brackets]): 

http://[IPADDRESS]:[PORT]/csp/bedd/BEDDLogin.csp, where: 

• IPADDRESS is the IP name or Address of your Ensemble installation or CSP 
Gateway. 

• PORT is the port number used for the portal or gateway. 
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Note: Modify the URL to HTTPS if using a CSP gateway with an 
active and signed HTTPS encryption certificate. 

5. Click Next to display the Create Shortcut wizard, set name step. 

 
Figure 8-2: Create Shortcut wizard, set name step 

6. In the Type a name for this shortcut field, type ED Dashboard. 

7. Click Finish. 

To test, double click the new shortcut. If the setup was completed correctly, the 
Dashboard Login web page (Figure 8-3) should display. 

 

Figure 8-3: Dashboard Login web page 

8.2 EHR Setup 
To access the EDD from the EHR, the latter’s graphical user interface (GUI) must be 
modified: 

1. Log on to EHR. 

2. Right-click in the title bar at the top of the EHR window and select Design Mode 
(Figure 8-4). 
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Figure 8-4: EHR window with right-click menu displayed 

3. Select Desktop Properties from the Design menu (Figure 8-5) to display the 
Properties for Desktop dialog (Figure 8-6). 

 
Figure 8-5: Design menu 
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Figure 8-6: Properties for Desktop dialog 

4. Select Customize Menus from the Property list 

5. Click the blue plus sign (+) to display the Menu Items pane (Figure 8-7) with a 
blank menu entry at the bottom of the list. 

 
Figure 8-7: Properties for Desktop dialog: Menu Items pane 
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6. Type ED Dashboard in the blank menu entry. 

7. Click Apply; the ED Dashboard dialog (Figure 8-8) displays. 

 
Figure 8-8: ED Dashboard dialog 

8. In the Edit action field of the ED Dashboard dialog (Figure 8-8), type the path 
to Internet Explorer followed by a space and the EHR URL. Replace IP address 
and PORT with values appropriate for the site: 
C:\Program Files\Internet Explorer\iexplore.exe http://IPaddress:PORT 
csp/bedd/BEDDLogin.csp?DUZ=$(user.handle)&SITE=$(site.handle)&LOC
=EHR 

9. Click OK to close the ED Dashboard dialog. 

10. Click OK to close the Properties for Desktop dialog. 

11. Click Save Settings. 

12. Exit Design Mode. 

13. Click the new tab Emergency Department Dashboard; the EDD main page 
(Figure 8-9) displays. 
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Figure 8-9: EDD main page 
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9.0 Configuration 
Setup of the Emergency Room beds and other aspects of the EDD are covered in the 
IHS Emergency Department Dashboard Users Guide BEDD0100u.pdf 
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Acronym List 

CSP Cache Server Page 

EDD Emergency Department Dashboard 

EHR Electronic Health Record 

ERS Emergency Room System 

GUI Graphical User Interface 

IHS Indian Health Service 

RPMS Resource and Patient Management System 
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Contact Information 

If you have any questions or comments regarding this distribution, please contact the 
OIT Help Desk (IHS). 

Phone: (505) 248-4371 or (888) 830-7280 (toll free) 

Fax: (505) 248-4363 

Web: http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm 

Email: support@ihs.gov 

http://www.ihs.gov/GeneralWeb/HelpCenter/Helpdesk/index.cfm
mailto:support@ihs.gov
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